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Introducing CorelDRAW® Graphics Suite X7

CorelDRAW® Graphics Suite X7 is an intuitive graphics
solution that empowers you to make a major impact with
your artwork. Whether you're creating graphics and layouts,
editing photos, or designing web sites, this complete suite
helps you get started quickly and stay on track.

Get up and running quickly

With CorelDRAW Graphics Suite X7, the redesigned
Welcome Screen now greets you as a docked tab in your
workspace. You can choose to keep the Welcome Screen
open, or float it in a separate window, so that you have

ready access to its wealth of content and helpful resources.

In addition to refashioned and more efficient default
workspaces, there are also a variety of alternatives to
choose from, including a Lite option geared for new users,
a Classic option, and advanced tailor-made options for
lllustration and Page Layout workflows. Plus, the toolbox,
dockers, and property bars now include Quick Customize
buttons, which make it easier than ever before to adjust
the workspace to suit your particular needs.

Work faster and more efficiently

CorelDRAW Graphics Suite X7 offers new ways to help
you work fast and efficiently. You can now maintain
multiple open documents in a tabbed view, instantly
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switching back and forth among them. And for those
who work with multiple monitors, you can drag a
document out of the application window and place it
within a second screen. There's also a new Font
Playground docker that offers an easy way to give fonts,
and their OpenType features, a dry run before
committing them to your artwork.

You'll experience greater control and improved methods
for applying and adjusting fills. The enhanced Object
Properties docker introduces new interactive controls
that will help you browse, preview, and transform all fill
types. And you can now create elliptical and rectangular
fountain fills, and apply transparency at the node level
within fountain fills. You can also save and share
fountain fills, vector pattern fills, and bitmap pattern fills
in the new community-driven Content Exchange.

Design with creativity and confidence

CorelDRAW Graphics Suite X7 offers a refined user
experience and imaginative new options that will help
you design with creativity and confidence. With
CorelDRAW® X7, a new Alignment and Dynamic Guides
docker provides more immediate access to alignment
choices. And in Corel® PHOTO-PAINT" X7, new
alignment guides appear on the fly to help you position
objects quickly, easily, and accurately. Plus, the new



Guidelines docker in both applications makes it easier to
add and arrange guidelines.

We've also made several enhancements to the Color
Styles docker that make it easier to view, arrange, and
edit color styles. And with new harmony rules, you can
instantly find complementary color schemes, which is
especially useful for producing iterative versions of your
artwork. CorelDRAW X7 also offers extensive options for
creating unique, artistic, and scalable QR codes.

Corel PHOTO-PAINT X7 includes various new tools and
creative options for retouching photos, such as the
Liquid tools, Unsharp Mask Lens, Planar Mask tool, a
series of camera effects, and interactive brushstroke
feathering and transparency.

Share and expand your experience

With the introduction of the Content Exchange,
CorelDRAW Graphics Suite X7 offers a convenient way to
help you discover, use, and share fountain fills, vector
pattern fills, and bitmap pattern fills. In both CorelDRAW
and Corel PHOTO-PAINT, the Content Exchange provides a
new Fill picker that makes it easy to vote for and sort your
favorite assets. And the Content Exchange is also
searchable from Corel® CONNECT", so you can easily add
assets to your project trays. What's more, two free
companion mobile apps, Patterns for iOS7 and Designs for
Windows 8 Modern Ul, are available to help you gather

and share Content Exchange assets while you're on the go.

Choose your purchase option

In the interest of user choice, we're offering several
CorelDRAW Graphics Suite purchase options.

Perpetual

e CorelDRAW Standard Membership: anyone who
licenses a box or download of the suite is eligible for
this free membership option, which includes access
to performance and stability updates, as well as
access to online content and fonts

e CorelDRAW Premium Membership: this paid
membership option includes access to exclusive
online content, professional fonts, early access to
new features and services as they become available,
and automatic upgrades to the next major version of
the suite for as long your membership is active

Subscription

e 30-day Subscription: this option lets you rent the
suite for 30 days, and includes complete access to
online content, professional fonts, new features and
services as they become available, and automatic
upgrades to the next major version of the suite

e 365-day Subscription: this option lets you rent the
suite for 365 days, and includes complete access to
online content, professional fonts, new features and
services as they become available, and automatic
upgrades to the next major version of the suite
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Customer profiles

Graphics and creative professionals

Graphics and creative professionals in advertising and
printing industries spend much of their time creating
and editing graphics, working with text, and retouching
photos.

Other customers in this category focus primarily on sign
making, screen printing, engraving, and graphic design
for print and the web. These users frequently repurpose
and combine such content as graphic designs, scanned
logos, clipart images, and fonts.
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Occasional graphics users

Entrepreneurs and small to medium-sized businesses
often create marketing and communications materials
in-house. Often self-taught in graphic design, these
occasional users modify existing artwork, retouch
photos, and create ads, flyers, and other marketing
collateral.

Business users in medium-sized to large enterprises strive
to create professional, graphically rich projects ranging
from sales presentations to web graphics. They spend
considerable time reworking existing projects and
retouching photos to use in their marketing and
communications materials.

Hobbyists are self-taught and use graphic design
software occasionally for creative projects — such as
newsletters, calendars, banners, and photo layouts —
for personal or community use.
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What's included?

Applications

CorelDRAW® X7: This intuitive vector-illustration
and page-layout application meets the demands of
today’s busy graphics professionals and graphics
non-professionals.

Corel® PHOTO-PAINT™ X7: This professional
image-editing application lets you quickly and easily
retouch and enhance photos.

Corel® PowerTRACE™ X7: This utility is embedded
in CorelDRAW to help you quickly and accurately
convert bitmaps into editable vector graphics.

Corel® CONNECT™ X7: This full-screen browser lets
you access the suite’s digital content, the new
Content Exchange, and search your computer or
local network to quickly find the perfect
complement for a project.

Corel® Website Creator™": This application offers
a fast and easy way to design, build, and manage
websites.

Corel CAPTURE"™ X7: This one-click utility lets you
capture images from your computer screen.

* CorelDRAW Standard Membership required to
download this application.
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Supporting applications

Bitstream Font Navigator: This award-winning
font manager for the Windows operating system
helps you find, preview, and install fonts.

Barcode Wizard: This wizard guides you through
the generation of bar codes in a wide range of
industry-standard formats.

Duplexing Wizard: This wizard helps you optimize
your projects for two-sided printing.

PhotoZoom Pro 3: This plug-in lets registered
users export and enlarge digital images from
Corel PHOTO-PAINT.

WhatTheFont: This online font identification
service is integrated with CorelDRAW.

ConceptShare™: This docker in CoreIDRAW is a
convenient online collaboration tool that lets you
share artwork and ideas with colleagues and clients.

Content

more than 10,000 high-quality clipart images
2,000 photos
more than 600 professionally designed templates

more than 1,200 objects



75 interactive text frames

75 interactive PowerClip frames
more than 100 image lists
more than 400 Artistic Media
75 content-ready photo frames
more than 1,000 fonts

more than 400 pattern fills

Documentation

Quick Start Guide
Quick-reference card

Help files

Training

New! More than 5 hours of training videos, with
1.5 hours of new content

Hints docker
Video Hints
Tips & Tricks

New! Insights from the Experts

Minimum system requirements

Windows 8/8.1 or Windows 7 (32-bit or 64-bit
editions), with latest service packs

Intel Core 2 Duo, AMD Athlon 64

2 GB of RAM

1 GB of hard disk space

1280 x 768 or higher monitor resolution
DVD drive for installation by disc

Mouse or tablet

Microsoft Internet Explorer 8 or higher

Internet connection required for CorelDRAW
Standard Membership, performance and stability
updates, online content, and some features, such as
QR Codes, ConceptShare, Content Exchange
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Top new and enhanced features

CorelDRAW Graphics Suite X7 is an intuitive and
complete graphics solution that empowers you to make
a major impact with your artwork.

Get up and running easily

With a redesigned Welcome Screen, variety of alternate
workspaces, total customization options, and wealth of
project-ready content, it's never been easier to get
started quickly and stay on track.

New! Welcome Screen navigation: The Welcome
Screen has been completely redesigned, making it easier to
navigate and discover the abundance of available resources,
including Workspace selection, What's New, a Gallery of
inspiring user creations, application updates, Tips & Tricks,
video tutorials, the CorelDRAW.com community, as well as
Membership & Subscription information.

New! Workspaces: A variety of tailor-made, workflow-
specific workspaces have been introduced to help new
users get accustomed to the suite faster and easier.
We've worked with professional industry experts who
use the suite routinely to arrange tools and features for
specific tasks, such as Page Layout and Illustration.

New! Workspace selection: The revamped Welcome
Screen now includes a Workspace tab, which lets you

Reviewer’s Guide [ 12 ]

choose from a variety of workspaces that were designed
for different proficiency levels and specific tasks. For
example, there are Page Layout and lllustration
workspaces, a Classic option for longtime users, as well
as a Lite option for new users.

(’) Give it a try
V' Choosing a different workspace

1 In CorelDRAW X7, click the Welcome Screen tab.

If the Welcome Screen is not active, click Window »
Welcome Screen.

2 In the Welcome Screen, click the Workspace & icon
and choose one of the following:

Lite

Classic

Default

lllustration

Page Layout

You can also choose an alternate workspace at any
time by clicking Window » Workspace.

New! Lite workspaces: Designed to help new users get
accustomed to the suite more quickly, new Lite workspaces
for both CorelDRAW X7 and Corel PHOTO-PAINT X7
provide exploration-friendly, scaled-down options in the
toolboxes and property bars. The Lite workspaces were



designed to make each application’s most commonly
used tools more readily accessible and easier to find.

New! Default and Classic workspaces: The new default
workspaces for CorelDRAW X7 and Corel PHOTO-PAINT X7
have been refashioned to offer a more intuitive and efficient
configuration of tools, menus, status bar, property bars,
and dialog boxes. Plus, the Classic workspaces are still
included for longtime users who may prefer the suite’s
legacy appearance. There are also Adobe lIllustrator and
Adobe Photoshop workspaces, which will help new
users get up to speed within a familar environment.

New! Advanced workspaces: With CoreDRAW X7,
the new Page Layout and Illustration workspaces have
been designed in consultation with industry
professionals to better expose specific application
functionality. For example, the Illustration workspace
provides a toolbox loaded with drawing tools and a
readily accessible Color Styles docker.

New! Font embedding: You can now embed fonts when
you save CorelDRAW documents so that recipients can
view, print, and edit the document exactly as designed. This
is especially useful when sending a CorelDRAW file to a
print shop, ensuring that the document can be viewed and
printed accurately.

CorelDRAW X7 respects any restrictions encoded with each
font, so a font must support embedding to be saved with the
document. While some fonts cannot be embedded, most will

support embedding for either print and preview, or for editing.

You can now embed fonts in CoreIDRAW documents so that
they can be viewed, printed, and edited exactly as designed.

New! Simple customization: The toolbox, docker
space, and property bars contain handy new Quick
Customize @ buttons, which will help you tailor the
interface to suit your workflow. Available in both
CorelDRAW X7 and Corel PHOTO-PAINT X7, these buttons
offer a faster and more convenient way to add dockers to
your workspace, add or remove tools from the toolbox,
and add or remove items from a property bar.

CorelDRAW X7 (64-Bit)

b ¥ & & 2 | ==~—[v] a0 +

[ Preset

J Brush

& Sprayer

L Calligraphic

£ Pressure

4, Preset Stroke List

A Freehand Smoothing
[0 3 Wwidth

[J . Scale Stroke With Object
O3 Bounding Box

Reset toolbar ‘

Customize... }

The new Quick Customize buttons make workspace
customization faster and easier than ever before.
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(’) Give it a try
Y Customizing the toolbox

1 In CorelDRAW X7, click the Quick Customize @
button below the toolbox.

2 To add a tool, enable the check box beside its name; to
remove a tool, disable the check box beside its name.
To restore the default toolbar, click the Quick

Customize button and choose Reset toolbar.

3 When you are finished, click anywhere in the document
window.

New! Overflow buttons: For tablet and mobile device
users, or people using Windows with medium or large
fonts, new overflow buttons have been added to the
toolbox, property bar, dockers, and color palettes to
indicate the presence of additional controls that do not fit
within the workspace. You simply click an overflow button
to instantly access the hidden tools or controls.
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The addition of new Overflow buttons indicate
the presence of hidden controls.
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New! Lens corrections: The new Correct lens distortion
slider in the Straighten Image dialog box helps you preview
and adjust your image to quickly and easily remove pincushion
and barrel distortions. Pincushion distortions make photos
appear pinched in from the center, while barrel distortions
make photos appear pushed out from the center.

By dragging the slider to the right, you can reduce pincushion
distortions; conversely, dragging the slider to the left will
reduce barrel distortions. Plus, the preview window’s
customizable grid will help realign the distortion.

The new Correct lens distortion slider helps you reduce
pincushion and barrel distortions.

New & Enhanced! Content: CorelDRAW Graphics Suite X7
includes a wealth of project-ready content that you can
use to enhance your artwork. The suite’s content library
includes fonts, both bitmap pattern and vector pattern
fills, clipart images, photos, photo frames, templates,
objects, interactive text frames, interactive PowerClip
frames, image lists, and Artistic Media.

New! Volume licensing: For customers purchasing
volume licenses, CorelDRAW now provides both
Subscription and Membership options that include access to
online content, the latest features, and application updates.



Work faster and more efficiently

With advanced fill and transparency options, a new docker
for trying out fonts, and many workspace improvements,
CorelDRAW Graphics Suite X7 offers new ways to help you
work fast and efficiently — from concept to production.

New! Fountain fills: You can now create elliptical and
rectangular fountain fills, apply transparency to
individual color nodes within a fountain fill, repeat a fill
within a filled object, adjust a fill's angle of rotation, and
smooth the blend transition of a fountain fill.

With CorelDRAW X7, you can apply and adjust fountain
fills more quickly, accurately, and creatively by using the
new interactive controls in the Object Properties docker
or the new Edit Fill dialog box. In Corel PHOTO-PAINT X7,
the enhanced Edit Fill dialog box provides quick access to
all available controls for adjusting fountain fills.

Object Properties
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Fill

XD e L

Untitled
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The Object Properties docker provides new interactive controls
for applying and adjusting fountain fills.

(’) Give it a try
Y Working with fountain fills
1

In CorelDRAW X7, create an object, such as a square or
circle, and then click Window P Dockers P Object
Properties.

2 In the Object Properties docker, click the Fill & tab.

3 In theFill area, click the Fountain fill button, and
then click the Elliptical fountain fill [_] button.

4 Click the first node ¥ above the color band, open the
Node color picker, and choose a color.

To adjust transparency, click and drag the Node

transparency T slider.

5 Click the last node § above the color band, open the
Node color picker, and choose a color.

6 Move the midpoint slider below the color band to set
the midpoint between the two colors.

New & Enhanced! Vector and bitmap pattern fills:
With CorelDRAW X7, you can efficiently search for,
preview, apply, and interactively transform both vector
pattern and bitmap pattern fills by using the enhanced
controls in the Object Properties docker. You can also
save personally created or modified fills to the new FILL
format, which is supported by Patterns, a new iOS app
that makes it easy to create seamless bitmap patterns
from photos. What's more, patterns saved to the FILL
format are easily shared with other CorelDRAW Graphics
Suite users.
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Save Pattern X
| Language: | English il
Name: Required {}
I : : e
Tags: tag, tag °
®
| ®
‘ Share this with the Content Exchange ®
J Select a category v (N NN )
This is shared under a CC BY 3.0 license.
\

L X 71 N\
You can now save and share personally created or modified
vector pattern and bitmap pattern fills.

New! Edit Fill dialog box: In both CorelDRAW X7 and
Corel PHOTO-PAINT X7, the new Edit Fill dialog box gives
you more efficient access to all available controls for
Uniform, Fountain, Vector pattern, Bitmap pattern, Two-
color pattern, Texture, and PostScript fills. With
CorelDRAW X7, the Edit Fill dialog box also provides a
real-time preview as you make adjustments.

Edit Fill
XmEs®DE®
ao 8|

|RGB v H
Oy
R | 255 ¢
G 0¢
Modelz B o 4
RGB v
Color Viewers:
HSB - Hue Based (Default) v | Add To Palette
. Name:

The new Edit Fill dialog box provides total control
for working with all fill types.
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New! Fill picker: With both CorelDRAW X7 and
Corel PHOTO-PAINT X7, a new Fill picker makes browsing,
searching, previewing, and selecting fills quick and easy.
The Fill picker also provides access to both locally stored
fills and those available in the Content Exchange.

‘.:;FI"I FERDE=

Favorites
Upvotes
=|  Content Exchange
"~ (¥-a ot Abstract
i Animal
o b pecoutie
= Fabic
Floral
Food
Geometnc
Metal
Nature

CF 3 s

The new Fill picker makes it faster and easier to
find and choose a fill.

New! Fill creation: In CoreDRAW X7, you can now
instantly create new bitmap pattern and vector pattern fills
from selected objects in your workspace. When you have
applied a pattern fill, the Object Properties docker presents
the New from document button. When you click that
button, the cursor changes to the Crop tool so that you can
define an area of your workspace to use as a pattern.

Object Propesties
sl os
]

XEEEEL

Untited
>< L [ -]

N /| B0px x BOpx
N w

You can now create bitmap and vector pattern fills from selected
objects in your workspace.



New! Font Playground: In both CorelDRAW X7 and
Corel PHOTO-PAINT X7, the new Font Playground docker
introduces an easier way to browse, experiment with,
and choose the perfect font. You can easily add sample
text to view its appearance in different fonts, and a
handy Zoom slider lets you quickly adjust the size of
sample text. With a single click, you can also choose
whether the sample text appears as a single line,
multiple lines, or a cascading series of increased sizes.

The Font Playground also provides access to advanced
features within OpenType fonts. If a text sample uses an
OpenType font, and the selected characters have
OpenType alternates, simply select the text to display the
Interactive OpenType arrow and then choose which
features to apply.

Font Playground

QO Vivaldi v
L}

- &orem ipsum *

= K I ey

il

Lorem ipsum ...

Garamond Normal

% punoibie|q uoy

Lorem ipsum dolor sit amet. Duis
consetetur sit ut justo. Esse
feugait et dolore sadipscing eos
sed magna. Ut duis mazim kasd
adipiscing eum ut molestie. Sit
ipsum voluptua vero sanctus
eirmod. Justo clita ipsum magna
Ut duis mazim kasd. Esse feugait
et dolore sadipscing eos sed.

Lorem ipsu...
&orem jpsum dolor .
ivaldi R

Add another sample

With the new Font Playground, you can easily find the perfect
font by comparing and adjusting a variety of text samples.

(’) Give it a try
Y’ Previewing fonts with the Font Playground

1 In CorelDRAW X7, click Text » Font Playground.
The Font Playground docker opens, displaying a series

of Lorem Ipsum text samples.

2 Double-click a row of sample text, press Ctrl+A, and
then type your own sample text.

3 Click a row of sample text, and then choose Gabriola
from the Font List box.
4 Select a few characters of the Gabriola text, click the

OpenType feature indicator « , and then choose an
option from the drop-menu.

Enhanced! Object Properties docker: With CorelDRAW X7,
the redesigned Object Properties docker has a new tab
option that can help you gain efficiency by reducing
congestion. The Scroll/Tab mode button sets the docker to
present only one group of formatting controls at a time,
making it easier to focus on the task at hand.

Object Properties X Object Properties =
4/& ¥ mie g|& T i
% Outline b Outline 3
P e 0 F [ | pans | F
» - 3 ¥ I S
o ] x i@ ] o x
Ase S0P P e A 50 HPFFfE
- o= o= - o= o=
il I | L I |
& fn
MEEEE L

The Tab mode in the enhanced Object Properties docker offers
greater efficiency by presenting one group of controls at a time.
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New! Brush selector: With Corel PHOTO-PAINT X7, the
new Brush Selector helps you find the brush you're
seeking quicker by combining all brush categories and
brush types in one location. It also stores the settings for
the last five brushes you've used.

2 FeitTip Fine Streak Blend
P Marker Wispy light Wash
A Hiiiter - Detal
& chalk Fine Pt. Soft Fade
, Crayon Cover Blend
# Charcoal @ TemperaBlend ]
7 Pastel Medium Soft Bleed
‘ Watercolor Soft Wet Tempera
.‘, Artistic Scalloped Dab
Wispy Light Blend
v
® P

The new Brush selector in Corel PHOTO-PAINT X7 provides a
preview to help you quickly find the right brush.

Enhanced! Special characters, symbols, and glyphs:
The revamped Insert Character docker presents all
characters, symbols, and glyphs associated with a selected
font, making it easier than ever to find these items and
then insert them in your documents. Available in both
CorelDRAW X7 and Corel PHOTO-PAINT X7, the docker
includes a filtering option that lets you display only the
character subsets that you want. For example, you can
choose to display only the Cyrillic characters and symbols
for a selected font.
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You can quickly find a font’s available characters, symbols, and
glyphs by using the enhanced Insert Character docker.

&(’) Give it a try
v’ Using the Insert Character docker

1 In CorelDRAW X7, click Text » Insert Character (F11).

2 Inthe Insert Character docker, choose a font from the
Font list box.

3 To use the filtering option, click the Entire Font list
box, and enable the check boxes for the character
subsets that you want to display.

4 Double-click a character to insert it in your document.

New! Outline Position: With CorelDRAW X7, the new
Outline Position options help you create objects with more
precise sizes. The Outside outline, Centered outline, and
Inside outline buttons let you specify whether an outline is
positioned inside the object, outside the object, or an



equal combination of both. By positioning an outline
inside an object, you can more easily create layouts with
specific sizes because the outline will be rendered within
the object’s original dimensions.

o’

You can now specify an outline’s position so that it appears
outside (left), inside (right), or centered (middle).

Enhanced! Transparency: Transparency settings have been
added to the Object Properties docker in CoreDRAW X7,
making it faster and easier to apply and adjust object
transparency. New options help you to quickly specify
whether transparency is applied to an object’s outline, fill,
or both. Plus, you can instantly save transparency settings as

an object style to enable easy reuse of your favorite effects.

X
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You can quickly apply transparency by using the
enhanced Object Properties docker.

New! Object Styles previews: A new pop-up now appears
when you hover over a style in the Object Styles docker,
offering a quick preview of the style before it's applied.

Object Styles X
a5y Styles © (=]
& Outline 1 = &
SRl ol |
£3 Style Sets
= -
| | \V/.
@ Apply to Selected = -
A Fill L ] n L}
X W
M.

The Object Styles docker now offers a visual preview
of a selected style.

New! Welcome Screen docking: You can now keep
the Welcome Screen open as a docked tab in the
workspace or as a separate floating window, providing
constant access to its wealth of versatile resources.

Y CorelDRAW X7 (64-Bit) - Document # - 0 X
File Edit View Layout Object FEffects Bitmaps Text Table Tools Window Help a
TEERS XEk 6- B oo @ & [Fsk swho-

wr v R Q Qe K IgRKE

Welcome Screen X +

b T B O
P o WhatsNew
Q-] & B

| i

Sample  Document X +
R, Ce s 74 f

Get up and running easily

Welcome Screen ravigaton

L JLE N v |

- _7 .!o,’.

You can now dock the Welcome Screen in your workspace,
or float it in a separate window, so that you always
have immediate access to its vast resources.
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New! Multiple document interface: You can now work
with multiple documents in a tabbed view, which helps
you stay organized and quickly switch between several
active documents.

WY CorelDRAW X7 (64-Bit) - Untitied-3
Eile Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

B = = I L=} B s ([ v E
|Letter v/ IIEJ%?EO 2 IET = E‘ [la Units: inches v «Qv‘
|[¢ Untitled-1 Untitled-2 Untitled-3 R o
w ° P i
fv‘ o
L)
Q.
4
u

New tabbed interfaces in CoreIDRAW and Corel PHOTO-PAINT
let you quickly switch between multiple documents.

New! Undocking documents: \When working with
multiple documents, you can now drag a document
outside of the application window to undock it, which is
especially useful for multi-monitor workflows.

AN CorelDRAW X7 (64-Bit) - Untitled-5
Untitled-4 Untitled-5 X
w} ¢ ¢ 1

A CorelDRAW X7 (64-Bit) - Untitled-3 =

File Edit View Layout Object Effects Bitmap

g bR s L8]

Fye——— | T =1

Letter MBI 5]

“& Untitled-1 Untitled-2 )4

L <E . -]

B ¢ ;

év‘ o |

,

Q@ TIE W« o1 ¥ ¥ B[ager

"

"

You can now drag a document outside the application window
and place it within a second monitor.
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New! Support for high resolution monitors: Thesuite's
applications have been optimized for high DPI resolutions,
ensuring that user interface elements appear crisp and
legible when displayed on high resolution monitors.

New! Microsoft Visual Studio Tools for Applications 2012:
The inclusion of Microsoft Visual Studio Tools for
Applications 2012 enables you to develop VSTA
automations for all applications in the suite.

New! Welcome Screen - content notification: The
redesigned Welcome Screen now provides update
notifications directly in the navigation pane, so that you
will be immediately informed of any available new
content. This makes it easier to stay current with
CorelDRAW Graphics Suite application updates, content,
learning resources, and more.

B CorelDRAW X7 (54-Bit) - 0 X
Welcome Screen
« A A

-
3 cet Started
] wortspace Important update available

An impartant update is avadable which

s e iproves produa funaionaty and
© Need it mmmmmm
[ Galtery It is highly recommended that you download
gm" this important update immediately.

You must ext completely out of the application
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The Welcome Screen now provides a notification whenever new
application updates, content, or learning resources are available.



Design with creativity and confidence

CorelDRAW Graphics Suite X7 continues to refine the
user experience, providing you with new alignment tools
and color controls, and new creative options that help
you design with creativity and confidence.

New! Align and Distribute docker: The new Align and
Distribute docker provides quick and easy access to all
available alignment options so that you can position objects
with precision. Docking the alignment options keeps the
drawing window uncluttered, so you can instantly view the
effects of any align and distribute modifications.

There are also new options that you can use to align and
distribute objects from the edge of their outlines. Plus, you
can align objects with a reference point by specifying its
exact x and y coordinates.
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You can quickly and easily access all available alignment
options in the new Align and Distribute docker.

New! QR codes: With CorelDRAW X7, you can now
create unique, artistic, and scalable QR codes by adding
text, colors, and images. Popular in consumer advertising
and packaging, QR codes give smartphone users quick
access to a brand’s website which can offer additional
product information. The Object Properties docker
makes it easy to customize a QR code, and you can
create an object style that saves a fixed appearance for
the QR code to enable quick and easy reuse.

You can change the shape, outline width, color, and fill
type of the QR code pixels, change the background color
and fill type, and more. You can also choose which
information to include in the QR code, such as URL,
email address, phone number, SMS, Contact, Calendar
event, and Geo location. There's also a Validate option,
which analyzes the QR code to ensure it can be read by
QR code readers, smartphones, and scanners.
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CorelDRAW X7 provides extensive options
for the creation of QR codes.
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(’) Give it a try
Y’ Creating a QR code

1 In CorelDRAW X7, click Object P Insert QR Code.
You must be a CorelDRAW member to access this feature.
In the CoreIDRAW Graphics Suite X7 dialog box, type
your name and password, and then click Sign in.

2 In the Object Properties docker, choose an option
from the QR code type list box.

You can choose to enter a URL, Email address, Phone
number, SMS, Contact, Calendar Event, Geo
location, and Plain Text.

3 Click the Pixel fill type list box to choose a fill for the
QR code, then click the Pixel fill color list box to
choose a fill color.

You can click the Pixel fill settings -+ button to
access the Edit Fill dialog box to customize the fill.

4 Click the Pixel outline width list box to adjust the
outline with for the QR code’s pixels, and then click
the Pixel outline color list box to choose a color.

5 Click the Pixel shape list box to choose a shape for the
QR code’s pixels.

6 When you are finished editing the QR code, click
Validate.

Enhanced! Color Styles docker: The enhanced Color
Styles docker makes it easier to view, arrange, and edit
color styles and color harmonies. You can now specify
the brightness value for a color, and constrain the
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Harmony Editor’s selector ring, which preserves
saturation and hue while you adjust the color.

The Color Styles docker also offers convenient View
Options, including Hint View, which provides a visual
indication of all document objects that use a specific color
style, and Page Sorter, which displays thumbnails of all
pages in a document and previews changes as you adjust
colors. You can also click View » Page Sorter to access
thumbnails of all pages in a document, with live previews
of changes you make to the document’s color styles.

Color Styles

ColorStylel A

Drag here to add color style

Page Sorter View

G

Use large swatches

Show empty arms

Hint View

Amet. Lore
Lorem Diam

ipsum .

Page 1 Title Page Page 2 Content Page 3

The enhanced Color Styles docker offers new View Options
that make it easier to keep track of a document’s color styles.

New! Finding complementary colors: With new
harmony rules, you can snap all colors in a color
harmony to a rule-based system, which lets you modify
those colors while preserving the color harmony. You can
also use harmony rules to create a new color harmony
from scratch. There are six harmony rules that produce
five-color harmonies based on a selected color swatch.



(’) Give it a try
¥’ Using the Smooth tool

1 In CorelDRAW X7, click the Freehand %, tool (F5).
2 On the property bar, drag the Freehand smoothing

A slider to the left to minimize its value, and then
drag in the document window to create a jagged line.

3 In the toolbox, click the Smooth ™y, tool.

To adjust the size of the brush nib, type a value in the

Harmony rules help you to quickly find complementary Nib size box on the property bar.

colors that are based on a color harmony. To set the speed of the smoothing effect, adjust the

New! Smoothing objects: CorelDRAW X7 provides a Rate slider on the property bar.

new Smooth tool that you can use to remove jagged o
edges and reduce nodes in curve objects. You can digital pen, click the Pen pressure %’ button on the
control the smoothing effect by varying the size of the property bar.

brush nib, the speed at which the effect is applied, and 4 Drag along the edge of the jagged line.

by using the pressure of your digital pen or stylus.

To control the effect by using the pressure of your

New! Alignment Guides: The new Alignment Guides
in Corel PHOTO-PAINT X7 help you position objects more
quickly, appearing on the fly with suggested alignments
to other nearby objects. You can use the new Alignment
Guides docker to view, set up, and modify alignment

guides. And with new margin alignment guides, you can
now specify inset and offset values when aligning an
object relative to another object.

The new Smooth tool helps you to remove jagged edges
and reduce nodes in curve objects.
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The new alignment guides in Corel PHOTO-PAINT X7 make it
faster and easier to precisely position objects.

New! Alignment and Dynamic Guides docker: You can
use the new Alignment and Dynamic Guides docker to access
and modify the configuration of these guides more quickly.
With alignment guides, the new Intelligent Spacing guides
make it easier to precisely position objects with the same
spacing as nearby objects. Plus, the new Intelligent
Dimensioning guides help you scale or rotate an object in
relation to the dimensions or rotation angle of nearby objects.
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The new Alignment and Dynamic Guides docker provides quick
access to all options for arranging these handy guides.
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New! Guidelines docker: With the new Guidelines
docker in both CorelDRAW X7 and Corel PHOTO-PAINT X7,
it's never been easier to add, manage, and modify
guidelines. You can position guidelines with precision by
using x and y coordinates, alter the line style and color, set
objects and editable areas to snap to guidelines, and lock
guidelines to avoid accidental changes. Plus, you can set up
angled guidelines and specify their angle of rotation.

X ssujppng

(4303 in,0.000 in) 100.0°

The new Guidelines docker makes it easier to
add, manage, and modify guidelines.

New! OpenType support for Asian text: While working
with Asian text, you can now use advanced OpenType

typography features, such as widths, forms, vertical metrics,
kana glyph alternatives, and vertical alternates and rotation.

Test Prepertier. "
& ® o
o
ungn » i
e 7 B
Harmal EIETI

X : g
Al Il -

ol HaFa - -
A== *

RBRrOF X
R-¥F B

L3
A
fi

D U
B

You can now access advanced OpenType features for Asian text.



New! Liquid tools: In Corel PHOTO-PAINT X7, four new,
pressure-sensitive Liquid tools — Smear, Attract, Repel,
and Twirl — offer fresh creative options for retouching
photos. You can use these tools to reshape specific image
areas to produce unique artistic effects. Each tool responds
to the pressure of your digital pen or stylus, and provides
options that help you control the intensity of the effect.

With the Liquid Smear tool, you can push pixels around an
image area to produce distortion effects. You can set the
size of the brush nib, specify the amount of the effect to
apply, and choose between a rounded or pointy smear.
The Liquid Twirl tool produces twirl effects from image
areas. You can set the size of the brush nib, the speed of
the twirl effect, and the direction of the twirl from the
center of the brush. The Liquid Attract and Liquid Repel
tools pull pixels toward or push pixels away from an image
area. You can set the size of the brush nib and the speed at
which the pixels move.

Corel PHOTO-PAINT X7 includes pressure-sensitive Liquid tools
that provide new creative options for retouching photos.

(’) Give it a try
¥’ Using the Liquid Smear tool
1

In Corel PHOTO-PAINT X7, open an image, and then
click the Liquid Smear 2, tool in the toolbox.

2 To set the size of the brush nib, type a value in the Nib
size box on the property bar.

3 On the property bar, click either the Pointy smear “t.
or Smooth smear |7 button.
The difference between a smooth smear and pointy
smear is noticeable only with higher Pressure values.
4 To set the amount of smearing, type a value in the
Pressure box on the property bar.
To control the amount of smearing by using the pressure
of your digital pen, click the Pen pressure #| button.

5 Drag across an area of the image that you want to
smear.

New! Unsharp Mask Lens: With Corel PHOTO-PAINT X7,
the new Unsharp Mask Lens helps you sharpen photos
without having to apply the effect directly to an object.
This lens increases the contrast of adjacent pixels while
preserving both high- and low-frequency details, like edges
and large structures. You can have the lens cover the entire
image, or you can create a lens from an editable area that
you define. Plus, you can easily edit the lens by adding or
removing areas, and by adjusting the lens transparency.

New! Planar Mask tool: You can use the new Planar
Mask tool in Corel PHOTO-PAINT X7 to define a feathered
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editable area along parallel lines. When combined with a
blur effect, you can simulate depth of field, giving focus to
a particular object while blurring areas outside the planar
mask. You can modify the effect of the planar mask by
moving or rotating the lines, and you can also use mask
modes with the Planar Mask tool.

3

it

The new Planar Mask tool lets you define a feathered editable
area along parallel lines.

New! Interactive brushstroke transparency and
feathering: With Corel PHOTO-PAINT X7, you can now use

modifier keys to interactively adjust the transparency and
feathering of brushstrokes. This lets you apply transparency
and feathering on the fly, and works with the Eraser, Red-eye
removal, Clone, Touch-up brush, Paint, Effect, Image Sprayer,
Undo brush, and Replace color brush tools.

You can now apply brushstroke transparency and feathering
interactively.
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(’) Give it a try
V" Applying interactive brushstroke transparency
1 In Corel PHOTO-PAINT X7, start a new image, and
then click the Paint *, tool in the toolbox.
2 On the property bar, choose a brush preset from the
Brush type list box.

3 Drag in the image window to paint.

4 Hold down Alt, click in the image window to display a
transparency slider, and drag along the slider without
releasing the mouse button to adjust transparency.

5 Release the mouse button, and continue painting.

New! Special effects: Corel PHOTO-PAINT X7
introduces new camera effects, such as Bokeh blur,
Colorize, Sepia Toning, and Time Machine to help you
recreate historic photographic styles and give your
images unique visual appearances.

With the Bokeh blur effect, you can define an area of
focus and leave the rest of the image out of focus. You
can create a duotone image by using the Colorize effect
to replace all colors in an image with a single hue. The
Sepia Toning effect simulates a photo taken with sepia
film, which is similar to grayscale except with brown
tones. And with the Time Machine, you can choose from
seven historic photography styles ranging from 1839 to
the 1960s.



Corel PHOTO-PAINT X7 provides new camera effects to help

you create images with unique visual appearances.

)

2

Give it a try

Applying the Bokeh blur special effect
In Corel PHOTO-PAINT X7, open a photo.

In the toolbox, click the Planar Mask % tool.

Parallel lines appear; solid lines define the overall
editable area, and dashed lines define the feathered
area along the top and bottom of the editable area.

To adjust the size of the editable area, type a value in
the Selection range ¥ box on the property bar.

To adjust the size of the feathered area, type a value in
the Feather range © box on the property bar.

To rotate the editable area, type a value in the Angle

of rotation & box on the property bar.

To move the editable area, drag it to a new location.

Click Effects » Blur P Bokeh Blur.

In the Bokeh Blur dialog box, adjust any of the
controls until you are satisfied with the result, and
then click OK.

Share and expand your experience

With a new Content Exchange, fill sharing options, and
supportive mobile apps, you'll discover new ideas and
keep your artwork fresh with access to community-
generated and premium cloud-based content.

New! Content Exchange: The new Content Exchange
is an online repository that integrates with Corel
CONNECT and the suite’s applications, making it quick
and effortless to access and share vector fills, bitmap
fills, and fountain fills with a community of other users.

The new Content Exchange is a convenient platform for
community accessing and sharing of vector pattern,
bitmap pattern, and fountain fills.
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(’) Give it a try
¥ Using the Content Exchange
1

In CorelDRAW X7, start a new document, and then
click Help P Sign In.

2 Type your email address and password in the
appropriate fields, and then click Sign in.

3 Create an object of any kind, and then click Window
» Dockers P Object Properties (Alt+Enter).

4 |n the Object Properties docker, click the Fill € tab,
and then click the Vector pattern fill ]l button.

5 Click the Fill picker, choose Content Exchange, and
then scroll through the list of thumbnails.

6 Click a thumbnail, and then in the preview pop-up
that appears, click Apply 1.

New! Content Exchange - Vote up and Vote down: A
pop-up appears when you click an asset in the Content
Exchange, which gives you the opportunity to Up Vote or
Down Vote the asset. You can also sort Content Exchange
assets based on user voting.

Content Exchange
Abstract
Animal
necom, Green and Brown Scroll
Fabric by Corel
Floral in Content ExchangeFills\Decora...
Food .
Seaadtiic Decorstive, Abstract, Omamental

Design

Metal e
s ﬁ Vector
Objects
Seasons ] v =
Texture L [

You can vote for your preferred assets in the Content Exchange.
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New! Content Exchange - Favorites: You can
instantly set any asset that catches your eye in the
Content Exchange as a favorite, which is a quick and
convenient way to keep a list of content that you might
want to download later.

Fills v || Search
Favorites -
Upvotes
Content Exchange
Abstract
Animal
Decorative s
Fabric | Flowering Vine
Floral | by Corel
ora ~ inContent Exchange\Fills\Floral
Food
Geometric Flower, Vine, Nature, Blossom
el Fill
Nature ﬁ Vector B
Objects
: Vil ‘R o= =
Seasons
0 0 0
Texture

You can use Favorites to tag Content Exchange assets
for future download.

New! Sharing fountain and pattern fills: You can
now save personal fountain, vector pattern, and bitmap
pattern fills and share them in the new Content
Exchange, an online repository of community content
that can be downloaded and is accessible to anyone
with a corel.com account. You can also instantly share
personally created or modified bitmap pattern fills to the
new Patterns iOS app.

New! Syncing trays with Microsoft OneDrive: You
can now sync Corel CONNECT trays with Microsoft
OneDrive, which provides cloud-based access to your
tray contents on other computers or mobile devices.



New! Patterns: With this free new mobile i0OS7 app, you
can create seamless bitmap patterns from digital photos.
Available from the Apple Store for both iPhone and iPod

touch, Patterns offers intuitive controls for fine-tuning the
brightness, color, and luminance of your new patterns.

The default Patterns file format (FILL) is fully supported by
CorelDRAW Graphics Suite X7, and can also be saved to the
local Camera Roll library on your mobile device. You can also
output to PNG, which can be used in other graphics
applications, such as Corel® Painter®, Adobe Photoshop and
Adobe lllustrator. Plus, you can even instantly share your
patterns via email or by posting to Facebook.

12:61 PM

Content Exchange

You can create seamless bitmap patterns from photos and
share them with the new mobile Patterns app.

New! Designs: Whether you're on the go, or in the
office, this new Windows 8 app offers an easy way to
find and share the perfect image. Available for free from
the Windows App store, you can use Designs to search for
images online, including popular content providers such as
iStockPhoto, fotolia, and Flickr.

You can also access the graphic design gallery on
CorelDRAW.com and the Corel Painter art galleries on
Facebook. With its easy-to-access trays, Designs makes it
easy to save images for quick reference, reuse, and
sharing. Plus, you can save your trays to Microsoft

OneDrive for access anywhere, and saved trays are
automatically synced with CorelDRAW Graphics Suite X7
and the new Content Exchange.

The new mobile Designs app offers a great way to find,
access, and share images.
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CorelDRAW® Graphics Suite user favorites

CorelDRAW Graphics Suite users continue to enjoy many
of the following features that have been cornerstones of
the suite for years.

Interactive frames: You can efficiently generate mock-
ups and preview layouts by using interactive placeholder
frames. You can drag content over a PowerClip frame, and
choose whether to add the content or replace existing
frame content. With PowerClip frames, you can specify
centering the content within the frame or scaling the
content to fit proportionally within the frame. Plus, you
can create text frames from any closed curve object, and
you can edit the frame to take on any shape imaginable.

H Click here with H
H Text Tool to

Click here with
‘ Text Tool to H
: add Paragraph text :

The empty PowerClip feature helps you visualize a layout
before adding content.
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Color harmonies: You can group a document’s color
styles into a color harmony, which makes it quick and
easy to produce iterative designs with varying color
schemes. A color harmony combines two or more color
styles into a hue-based relationship. You can then modify
them collectively, altering color composition of your
artwork in one step.

In addition, you can also create a special type of color
harmony called a gradient, which consists of one master
color style and a number of varying shades of that color.
When you alter the master color, the gradient colors
automatically adjust to the same degree that the master
color was altered. This is especially useful when
outputting multiple color variations of the same design.

Color harmonies make it easy to change
combinations of colors.



Smart Carver™: In Corel PHOTO-PAINT, you can use the
Smart Carver to easily remove unwanted areas from a
photo and simultaneously adjust the photo’s aspect
ratio. The versatile Object Removal brush lets you choose
to paint either the area of the photo you want to
preserve or the area that you want to remove. When
adjusting aspect ratio, the Smart Carving presets let you
contract or expand a photo’s background vertically and
horizontally without distorting the photo.

o o 3
e

T,

The Smart Carver makes it easy to remove unwanted areas and
adjust the photo’s aspect ratio.

Interactive OpenType: With the Interactive OpenType
feature enabled, CorelDRAW will suggest eligible
features contained in OpenType fonts that you can apply
to your selected text.

Search capability in Corel CONNECT: You can quickly
leverage content assets from online sources by typing a
web address in the Corel CONNECT search toolbar. You
can also search the new Content Exchange, iStockphoto,
fotolia, Flickr, or a folder path for local or network
content.

Create clip mask: With clip masks in Corel PHOTO-PAINT,
you can adjust the properties of a group of objects in a
way that is non-destructive to the individual objects within
the group. For example, you can adjust transparency levels
for the whole group without altering the pixels of the
individual objects.

EEEE | ...

L i

The Create Clip Mask option gives you greater control when
applying effects to groups of objects.

Corel PowerTRACE: This utility lets you quickly and
accurately convert bitmaps into editable and scalable
vector images, which is especially useful for design work
that's based on existing artwork. PowerTRACE generates
a color palette, which lets you instantly edit, merge, or
delete specific colors used by the original artwork.

You can use PowerTRACE to convert bitmaps to vectors.
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Cutout Lab: This intuitive utility simplifies the process of
accurately cutting out specific areas of an image. For
example, you might want to extract a specific part of a
photo into its own object.

Image Adjustment Lab: This time-saver makes it easy
to correct common color balance and tone problems
from a single dialog box.
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You can save time by correcting images
with the Image Adjustment Lab.

Fit text to path: Both CorelDRAW and Corel PHOTO-PAINT
let you add text along the path of an open object (for
example, a line) or a closed object (for example, a circle).
You can easily adjust the position of the text in relation to
the path.

Interactive Fill tool: You can add uniform, linear,
elliptical, conical, rectangular, two-color pattern, vector
pattern, bitmap pattern, texture, and PostScript fills by
using the Interactive Fill tool.
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The Interactive Fill tool helps you apply bitmap pattern (top row),
fountain, vector pattern (bottom row), and two-color fills.

Smart Fill tool: This convenient tool detects the edges
of an area and creates a closed path so that the area can
be filled. By using the Smart Fill tool, you can fill
practically anything. For example, if you draw a freehand
line that crosses over itself to create loops, the Smart Fill
tool will detect the edges of the loops and fill them.

The Smart Fill tool helps you fill enclosed areas.



Mesh Fill tool: You can create unique effects by filling
an object with a mesh fill. For example, you can create
smooth color transitions in any direction without having
to create blends or contours. The Mesh Fill tool lets you
specify the grid’s intersecting points as well as the
number of columns and rows in the grid.

Dimension tools: CoreIDRAW includes several
dimension tools that make it easy to detail precise
measurements in your design. For example, dimension
lines can be used to display the size of objects, or the
distance or angle between objects. You can choose from
angular, parallel, horizontal, vertical, or segment
dimension tools.

Document palette: When you start a new CorelDRAW
document, a custom color palette is automatically
created. The palette is then saved with your file, which
gives you quick access to the project’s specific colors in
the future.

Fillet / Scallop / Chamfer docker: This docker makes
it easy to shape the corners of curve objects. Filleting
produces a rounded corner; scalloping rounds and
inverts the corner to create a notch; and chamfering
bevels the corner so that it appears flat.

)

You can fillet, chamfer, or scallop the corners of objects.

Contour tool: This tool helps you create interesting 3D
effects and cuttable outlines for output to devices, such
as plotters, engraving machines, and vinyl cutters. When
you contour an object, you add evenly spaced concentric
shapes that progress to the inside or the outside of the
object’s borders.

The Contour tool helps you create 3D effects.
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Drop Shadow tool: You can create drop shadows that
simulate light falling on an object from either a flat,
right, left, bottom, or top perspective. You can also easily
adjust attributes of the drop shadow, such as color,
opacity, fade level, angle, and feathering.

Color Proof Settings docker: This docker helps you
efficiently prepare artwork for various output devices.
You can save presets, choose from a list of output

devices to preview your output, export soft proofs for
client approval, and print hard proofs from the docker.

You can prepare artwork for various output devices with the
Color Proof Settings docker.

Artistic Media: The Artistic Media tool gives you access
to the Brush, Sprayer, Calligraphic, and Pressure tools.
With each of these tools, you can create pressure-
sensitive lines which vary in thickness.
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